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Version 8.0 Quick Start 
 

 

 

Staff Files and Staff Files Pro offer flexible systems for the storage and retrieval of important, confidential 

personnel information. Both are electronic filing systems that use a familiar interface—folder tabs. Through 

the quick-tab navigation system, you can easily and quickly find personnel information. 

 

With Staff Files and Staff Files Pro, record keeping becomes effortless. You can easily store the information 

you need, from employee names, addresses, and phone numbers to performance evaluations, benefits 

packages, and vacation time accruals. In fact, you can store just about anything because both let you define 

the type of information you want to keep. 

 

You can use the HR Documents tool in Staff Files Pro, to create your employee forms, policies, and more, 

including employee handbooks and manuals, using a library of professional templates you customize with 

your details. Staff Files Pro also features an audit trail tool that helps companies keep a log of activity, such 

as types of changes made to records and by whom, when multiple users have access and make entries. 

 

What You Can Do with Staff Files 

It’s efficient, flexible, effective, and secure. 

 

Here's a sample of what you can do with Staff Files & Staff Files Pro: 

Introducing! Use the new Evaluations Score report to quickly identify the top performing employees in your 

company. This report lists total and average overall performance scores – as well as the number of 

evaluations completed and the category average score – for each employee. Sorting employees by category 

average allows you to examine comparable scoring throughout your company even though the employees 

may have different evaluation criteria, number of categories, or number of evaluations. 

Introducing! With the Accruals Balance report, a list of your employees and their available time off – 

vacation, sick, or other – is easily displayed for the date you choose. 

Introducing! Now, Manage Security offers the option to limit access to the Define menu which locks your 

drop-down lists and auto accrual time-off policies so other managers cannot make modifications. 
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Improved! Scan multiple-page documents directly into one file with Staff Files enhanced scanning options. 

Improved! Filters and sorts for city, state, country, and manager add even more flexibility. 

Improved! Employee List options have been expanded to include any field from the General, Emergency, and 

User tabs. 

Improved! Now add signature lines to your Employee Evaluations report for performance review records. 

Improved! Use the Accruals Activity report to display all earned and deducted transactions, plus any 

adjustments made according to your auto accruals policies. You will see the beginning balance, ending 

balance, and all activity for the date range you choose. 

Efficient 

 Organize employees by department or by location if you are maintaining information for multiple 

facilities. 

 Keep employee emergency information readily available—contact name and number, physician name 

and number, even special notes—with space to record both primary and secondary contacts. 

 Import employee photos and other important documents such as I-9 forms, licenses, and resumes with 

the file management features in the Documents tab. 

 Group enrollment tools are time-savers that provide the option of using batches to enroll a group of 

employees at one time in auto accrual policies and training programs versus enrolling each employee 

individually. 

 Training tab displays total hours of training by category and searches records for employees that may be 

missing a particular training. 

 Auto Accruals wizard uses your Accrual Accounts and Accrual Policies for a simple solution to setting up 

and tracking accruals automatically, like vacation and sick time. 

 The Incidents tab affords more consistent reporting of disciplinary actions, warnings, accidents, or other 

workplace occurrences. 

 Track wage histories and current pay rates. 

 Enter and update employee data with the convenience of text file imports. 

 The user interface includes monitor optimization to 1024 x 768. 

 Print mailing labels and phone lists. 

Flexible 

 Staff Files and Staff Files Pro are compatible with Windows 7. 

 HR Documents puts a complete library of professional HR templates and PDF files at your fingertips, 

which you can quickly customize and produce. Your company’s details, complete with contact 

information and logo, are automatically included on all HR materials produced. (for Staff Files Pro users) 

 Prepare over 30 different reports, including reports for accrual balances, reminders, absences, and 

separations. 



  3 Staff Files & Staff Files Pro version 8.0 

 

 The benefit reports provide simple access to the details about employees enrolled in your benefit plans. 

The Benefits by Plan staff report lists all enrolled employees by benefit plan, and it subcategorizes by 

plan, such as healthcare, dental, or retirement. The reports list the employees’ names, enrollment date, 

employee contribution, and employer contribution. 

 Ready-to-use templates for evaluation forms, new hire checklists, separation checklists, and more are 

included – you can use them as is, or modify each to suit your needs. 

 Absence Calendar gives you a visual representation of when employees are out of the office, for example 

on vacation or out sick, including the start date and end date. 

 Use the expanded import options for text files for employee number, cell phone, fax number, I-9 renewal 

date, position, and the fields from the Emergency tab, in addition to full name, first name, middle initial, 

last name, hire date, city, state, zip, address 1, address 2, social security number, home phone, work 

phone, e-mail address, and  birth date. 

 In the Employee Training report, the Training Category column displays total hours of training by 

category. The Training Expirations staff report displays a list of employees whose training has expired 

and employees who have not yet attended the particular training. 

 Create different sets of performance evaluations for each location, department, and position. Choose the 

evaluation categories that are specific to each group of employees. Plus, include a description for each 

category, so when managers fill out the evaluation form or when employees read their evaluation, 

everyone will have a better understanding of the criteria for each category. 

 With the name format options and column you see more at one time, and you choose the way you want 

the names displayed. 

Effective 

 Audit trail tool helps companies keep a log of activity, such as changes made to records and by whom, 

when multiple users have access and make entries. (for Staff Files Pro users) 

 Use employee-specific reminders to keep current on individual performance evaluations, training 

requirements, or other items you can define to fit your workplace. 

 Create repeating pop-up reminders to keep you informed of common all-employee events and details, 

such as birthdays, certification expirations, and I-9 renewals. 

 Complete thorough performance evaluations by scoring employees on categories, such as availability 

and job knowledge, and include detailed comments. 

 Spot trends in why people leave your company with the Separation Reason field of the Staff Separation 

by Date report. In the report, you can see how long employees worked at your company before they left, 

the manager they reported to, and the reason for the separation.  

 COBRA tracking can be recorded in the Separation Tab. Store enrollment date, declined date, payment 

amount, end date, and miscellaneous notes for COBRA. Use the COBRA staff report to display your 

former employees’ information by separation date. 

 Create, edit, and publish letters for benefit notifications and other workplace communications. 

 Check which benefits employees are enrolled in, and when they will become eligible for additional 

benefits. 
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 Record general employee information—social security number, EEO code and category, hire date, 

position, and W-4 status. 

 Define your own list box items for tab information fields to customize Staff Files and Staff Files Pro so 

they meet your unique workplace needs. 

Secure 

 Segment security access by department and provide managers access to their department-specific Staff 

Files and Staff Files Pro information. 

 Restrict access to confidential information with password protections – even create a password to 

protect your Microsoft Access database from unwelcome viewing. 

 

About this Guide 

The Quick Start guide focus is how to use the Staff Files programs and it’s written for end-users who have a 

need to enter, maintain, and update confidential employee information.  

  

The best way to quickly become familiar with Staff Files is to review the basics in these sections. 

  

Introduction 

The introduction section provides a basic description of features and functions. 

 

Installing Staff Files 

This section explains how to use the Setup program to install the software. You can install Staff Files or 

Staff Files Pro for use with Windows 2000 or higher. The section covers installation for both single- and 

multi-user versions. 

 

Getting Started -- A Quick Tour  

This section is an overview with how-to instructions for various features presented in a simple, step-by-

step format. 

 

Setting Your Specifications  

Find instructions for setting up the program to meet your company-specific requirements. 

  

This guide assumes you are already familiar with Microsoft® Windows 2000 or higher and MS-DOS® operating 

systems. It also assumes you know and understand the basics of operating a mouse.  If you need more 

information about Windows, MS-DOS, or operating a mouse, please refer to their respective manuals. 
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Introduction 

This section explains how the conventions of the guide and additional resources available to help you 

understand the features and functions of the program.  

What’s in this section 

Quick Start Guide Conventions 

Getting Help 

Technical Support 

 

Quick Start Guide Conventions 

Refer to the following conventions when becoming familiar with the program: 

 

Menu names and commands are shown in bold type with the underlined letter used to invoke a menu or 

command in combination with the Alt key.  For example: 

 

Click on File and select Backup. 

 

Notes are used to point out information of special interest. For example: 

 

Note:  Photos should have been scanned and 

saved in a .bmp or .jpg format. 

 

Step-by-step instructions are clearly demonstrated with numbered sentences. For example: 

 

To Change a Field Label: 

 

1. Go to the tab that contains the label 

 you want to change. For example, 

 click the General tab. 

 

2. Place the cursor on the Department label 

 and double-click. 

 

Getting Help 

When you need help with a specific function, command, or procedure, select Help from the Staff Files menu 

bar. For additional information about any of the elements that appear in the Help screen, point to the term or 

element and double-click the left mouse button.  
 

The Help menu also allows you to check for updates to the Staff Files program. The most recent Staff Files 

updates are posted to the ABS web site, and can be downloaded by selecting HelpCheck for Updates. The 

update may take several minutes to complete. Before beginning, you must close down all open Staff Files 

applications, and make sure multiple users are not logged in at the time. When the update begins, your Staff 

Files application will automatically close. 
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In the Help menu, you will also find an online feedback form you can use to share your comments and 

suggestions about Staff Files and Staff Files Pro. 

 

We encourage and appreciate all customer feedback. It is valuable in shaping the future versions of these 

products and improving the service and support we provide our customers.  
 

Technical Support 

We’re here to help you… If you can’t find the answer to your question after consulting the Help topics, 

contact Technical Support. 

Internet E-mail: support@abs-usa.com 

World Wide Web: http://www.abs-usa.com 

Telephone: 1-701-235-5226  

 8:00 a.m. to 5:00 p.m., CST 

 Monday through Friday 

 

Free Technical Support Period: 

ABS offers 90 days of free technical support to registered Staff Files users. Free technical support starts 

from your date of purchase. Thereafter, there is a $35 charge per incident. ABS also offers 12-month, 

unlimited Technical Support Plans and Software Enhancement Plans. For just pennies a day, we can help 

keep your software up and running.  

Support Plans: 

 Unlimited telephone and e-mail access to ABS Support Technicians 

 Free media replacement should your software become lost or damaged 

 Free updates to address compatibility issues (does not include upgrades) 

 For Support Plan pricing, please call 1-800-874-8801 

Software Enhancement Plans: 

ABS offers a 12-month, Software Enhancement Plan entitling you to Free upgrades, in addition to everything 

included in a Support Plan. For Software Enhancement Plan pricing, call: 1-800-874-8801. 

mailto:support@abs-usa.com?subject=Technical%20request%20inquiry
http://www.abs-usa.com/
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Installing Staff Files 

This chapter describes how to install Staff Files and Staff Files Pro to run under Microsoft Windows 2000 or 

higher for both single- and multi-user versions. 

What’s in this section 

What You Need to Run Staff Files 

How to Install Staff Files 

How to Install Multi-User Versions of Staff Files 

Using Your Own Database 

What you need to run Staff Files 

The minimum software and system configuration you need to run Staff Files includes: 

 A personal computer with an Intel® Pentium® Processor (75+ MHz) and at least 256 MB of memory. 

 One CD-ROM drive and a hard disk, with at least 120 MB of free disk space for program files, plus 

additional disk space for personnel data files. 

 Windows operating systems: 2000/NT*/XP/Vista/7. 

 A mouse and monitor supported by Microsoft Windows 2000 or higher. 

 1024 x 768 screen resolution or higher. 

 An optional printer supported by Windows 2000 or higher. 

*NT is supported only when acting as a server in multi-user, client/server environments. 

 

How to Install Staff Files 

Be sure you are logged in as ―Administrator‖ or have administrative rights to install the application. We also 

recommend that you close all applications, including screen savers or similar programs, before running the 

Setup program. (If you purchased a multi-user version of Staff Files or Staff Files Pro, use these steps to 

install the software on each individual workstation.) 

 

Follow the instructions listed below to install Staff Files using Windows 2000 or higher. 

 

1. Insert the Staff Files CD into your computer’s CD ROM. 

 

2. The Setup program should run automatically. If not, complete the following steps. 

 

• Click on the Start button. 

• Select Run from the Start menu. The Run dialog box is displayed.  

• Type d:\setup.exe in the dialog box (use the appropriate drive letter for your CD-ROM). 

• Click OK or press the Enter key. 

 

NOTE: The Setup program can not run automatically if Autorun is inactive. 
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The Setup dialog box will be displayed. Complete the setup by following these steps: 

 

1. Click Next at the Welcome screen and the license agreement is displayed. After reading it the license 

agreement, click Next to accept it. 

 

2. The Installations Options screen appears. Select the ―Anyone who uses this machine‖ option to allow 

other users access to the program on your PC. Or, select the ―Only for me‖ option if you are the only 

user that should access the application on your PC. Then, click Next. 

 

3. The Destination Location window is displayed. The Setup program will install Staff Files software to 

the directory c:\Program Files\Staff Files. It will automatically create the directory on your hard disk, 

if you haven’t done so already. 

 

 To install the program to another directory, click Browse and enter or select a destination directory. 

Click Next. 

 

 NOTE: The corresponding database(s), PswdE.txt, PswdS.txt, IMG folder, and SFLetters folder will be 

located in c:\Documents and Settings\All Users\Documents. 

 

4. The Start Installation screen is displayed. Click Next, and Staff Files starts to copy the program files 

to the designated directory and updates the system configuration. 

 

5. The Setup program notifies you that Staff Files has been successfully installed. The Setup program 

automatically adds Staff Files to Start Programs ABS Applications group. 

 

6. Click Finish and the Setup program will add a Staff Files shortcut to your desktop. 

 

7. Start your Staff Files application by double-clicking the desktop shortcut. 

 

How to Install Multi-User Versions of Staff Files 

1. Follow the instructions listed on page 6 of this section to install a multi-user version of Staff Files 

using Windows 2000 or higher. 

 

2. The Network Wizard is automatically launched when Staff Files runs for the first time on a 

workstation. This wizard is used to set up the location of the database, and to share that folder. Click 

Next at the Welcome screen. 

 

3. After a search of the network has been completed, an installation options dialog box will appear. If 

this is the first time a multi-user version of Staff Files is installed to a computer on your network, then 

you will need to select Option #1; if not, then select Option #2.   
 

Continue setup with the procedure for Option #1 or Option #2. 
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Option #1: 

 

1. Click Next, after selecting Option #1. 

 

2. The database will be installed to the directory, c:\Staff Files folder. To install the database to another 

directory, click Browse and select a destination directory. Click Next to create the directory.  

 

3. Click the Share button to share the folder. The Staff Files Properties dialog is displayed.  

 

• Windows XP Home/Pro (with Simple File Sharing):  

Mark the Share this folder on the network and Allow network users to change my files check 

boxes. Then, click Apply and OK.  

 

• Windows XP Pro/ NT / 2000:  

Select the Share this folder option, then select the Maximum allowed option in the User limit 

field. Click Apply. Next, click the Security tab and select Users or Everyone, and give full control by 

marking the Full Control check box. 

 

4.  Click Next. 

  

5.  Click Finish. Staff Files is automatically launched. 
 

Option #2: 

 

1. Click Next, after selecting Option #2. 

 

2. Locate the Staff Files database by choosing an automatic search of the network (this could take 

several minutes), or by clicking Browse to search yourself. 

 

3. Click Next when you have located the database. 

 

4. Click Next and Finish.  

 

Using Your Own Database 

If you have your own database, and wish to use it instead of the one in your Staff Files folder, both single-

user and multi-user versions should complete the following: 

 

To set your database: 

 

1. Rename the databases in the Staff Files folder on your computer to Empf_Old.mdb and 

Samp_Old.mdb. 

 

2. Copy PswdE.txt, PswdS.txt, IMG folder, and SFLetters folder to the server, if they are not already on 

the server. 

 

The next time you start Staff Files, you’ll be asked to locate the database. Simply, direct Staff Files to the one 

on the server. 
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NOTE: Whenever the Staff Files database is moved from the default location to another location, users must 

also move PswdE.txt, PswdS.txt, IMG folder, and SFLetters folder into the same folder as the Staff Files 

database. 

 

Important Information About Network Installations: 
If you purchased a Staff Files multi-user license but do not have a network or you do not wish to install the multi-user 

version on a network, you can install the software on as many workstations as you have licenses. The only legal 

requirement is that you must install all copies within the same company. You cannot purchase a single copy of the 

multi-user version and install it at more than one company. 

 

As an option, you can install a complete copy of the software on individual workstations using the appropriate Setup 

program. For installation instructions refer How to Install Staff Files. You may want to use this option when a user does 

not want to boot their system from the network, or they want to be able to run Staff Files if the network server is not 

available. In this situation, data can still be accessed. 

 

You are ready to begin. Review the next section to learn more about using Staff Files software. 

 

Getting Started  A Quick Tour 

This section describes how to start up the program and use the menus, quick-action buttons, and tabs. 

What’s in this section 

Starting Staff Files 

Working With Staff Files 

 

Starting Staff Files 

The Staff Files and Staff Files Pro programs provide an easy-to-use, intuitive interface. The design is based 

on something you are already familiar with—file tabs. The file tabs presented in each system allow you to 

enter, view, and edit information about your personnel. You can also customize the information you need to 

keep track of in each tab. 

  

To start Staff Files: 

 
1. Begin by clicking Start and selecting ProgramsABS ApplicationsStaff Files. 

 

2. If this is the first time you’ve used Staff Files, you will see a Registration dialog box. Select the 

appropriate choice, and follow the instructions. 

 

3. Click OK to continue. 

 

4. Next, you’re asked if you wish to use Sample data or Live data. 

 

5. Click the Live data button. 
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The Staff Files program screen appears with Current Reminders at the front. You can see how the 

reminders you set will be displayed.  

 

6. To close reminders, click the Close button. 

 

Working with Staff Files 

Menu Bar 

At the very top of the program screen is the menu bar. From the menu bar you can perform functions like 

defining your own list box items for the information fields, setting reminders, and printing reports. 

 

 
 

Tool Bar 

Directly below the menu bar is the tool bar containing the quick-action buttons. Pass your cursor over the 

buttons to see how the Tool Tips display the specific function of each button. 

 

 
 

The Add button allows you to add employees to your database.  

The Delete button lets you delete employees and information from your database. 

The Find button allows you to search for a specific employee by name, social security number, or 

employee number. 

The Filter and Sort button allows you to use your own filters to increase viewing and reporting options. 

You can combine filters with different sorts to narrow data into specific categories or groups. For 

example, you could sort your staff by hire date, and further condense with a filter to include only those 

hired after 1/1/2000. 

The Calendar button gives you access to a handy calendar for referencing dates. (You’ll find this same 

tool in date information fields.) 

The Calculator button gives you a pop-up calculator you can use at any time. 

Click this button to launch Visual Staff Scheduler Pro. 

Visual Staff Scheduler Pro is a fast, easy, and flexible program designed to take the complexity out of scheduling. 

One, easy-to-use interface makes it simple! Visit www.abs-usa.com, or call 1-701-235-5226 for more details. 

 The Photo button allows you to add a photo to the employee’s record. 

The Print button allows you to print directly to your printer. 
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Tabs 

Below the tool bar’s quick-action buttons, you’ll find the quick-tabs. The first tab displayed, at the far left, is 

the General tab. 

 

 
 

The General tab has several information fields, such as First Name, Last Name, Birth Date, Address, etc. 

After adding an employee, you just type the information into these fields. Click the other tabs to see the 

other types of employee information you can keep. When you are finished looking at the other tabs, click the 

General tab again. 

 

Employee List 

At the far left of the screen, you’ll see a list of employee names. This list gives you a view of your personnel 

roster at all times. You can also use the employee list to retrieve information you’ve entered in the tabs. 

 

 
 

You can use filters and sorts to arrange the list in a category or group for easy reference. Click an employee 

name. Notice how your General tab now displays the information for this employee. 

 

Drop-down Lists 

Notice the information fields in the General tab that have a drop-down arrow next to them, such as Status 

and EEO Code. The drop-down arrow indicates you can select an item from a drop-down list. 

 

Five information fields have lists of the most commonly used items already defined for you. For example, the 

EEO Code list box items already defined are ―African American,‖ ―Asian,‖ ―Hispanic,‖ ―Native American,‖ and 

―White.‖ 

 

You also have the ability to define your own list box items. Now, using Status for an example, you may decide 

to include maternity leave in your list of status choices. 
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To see how the items in drop-down lists are defined, follow these steps: 

 

1. Click the Define menu. 

 

2. Select Status. 

 

3. Click the Add button and a new line is displayed. 

 

4. Click in the new line and enter ―Maternity.‖ 

 

5. Click the Close button. 

 

6. In the General tab, click on the drop-down arrow for the Status field. ―Maternity‖ is now in the list. 

 

The Define menu allows you to define items for the following: Accrual Accounts, Department, EEO 

Category, EEO Code, Location, Position, Status, W-4 Status, Wage Type, Benefit Categories, Checklist 

Items, Evaluation Categories, Incident Categories, Note Categories, Training/Certification, Document 

Categories, Reminder Settings, Filters, Sorts, and Backup Reminder. 

 

Hot Keys 

Hot Keys give you the ability to navigate through your Staff Files database using your keyboard. This is done 

by using a letter in combination with the Alt Key. Menu names and commands with Hot Keys are shown in 

bold type with the underlined letter needed. 

 

To use hot keys: 

 

1. Push the Alt Key. The underlines are displayed. 

 

2. For example, Alt + D opens your Define menu. 

 

NOTE: When the same letter is used for different items, (EEO Code and EEO Category) simply 

continue selecting the letter until you reach the item you’re looking for. 

 

This completes a quick tour of the Staff Files program. From this tour you have learned how: 

 The quick-action buttons are used to maintain the employee database and to print employee records. 

 The quick-tabs contain employee information in thirteen different categories. 

 The Define menu is used to define items you can customize to your needs. 
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Setting Up Your Staff Files 

This section describes how to set up user-defined items, change information field labels, and define custom 

sorts and filters. Start Staff Files by clicking on Start and selecting Programs ABS ApplicationsStaff Files. 

When the dialog box appears, select Live data. 

What’s in this section 

Set Up List Items 

Define Menu 

Define Accrual Accounts 

Define Auto Accrual Policies 

Change a Field Label 

Enter Dates 

Custom Sorts 

Custom Filters 

Set Up & View Reminders 

Manage Security 

 

Set Up List Items 

Before entering employees and their information, you may want to define the items specific to your company 

in the following tabs: 

 General 

 Benefits 

 Accruals 

 Evaluations 

 Notes 

 User 

The items you define are displayed in each of the lists that appear in the tabs. An example of an information 

field in the Evaluations tab with such a list is Evaluation Categories. In the Evaluations tab, you will enter 

performance scores and notes for the evaluation categories you select or define. 

 

Staff Files has some of the most commonly used items already defined for you in the various information 

fields. For example, in Evaluation Categories you will find nine categories pre-defined, including Initiative and 

Reliability. 

 

By simply adding and deleting, you can personalize the drop-down lists in the information fields. Each 

window utilizes Add or Delete buttons that you’ll use to define the information required to meet your specific 

company needs. 
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Define Menu 

Before entering employees and their information, you want to define list items specific to your company 

using the Define menu. You may choose to limit access to the Define menu to keep some or all managers 

from making changes to your company-defined information, such as accrual policies. You can do so using 

Manage Security settings in the File menu. The items you define will appear in the drop-down lists of the 

appropriate tabs. 

 

 Accruals  Benefit Categories 

 Department  Checklist Items 

 EEO Category  Evaluation Categories 

 EEO Code  Incident Categories 

 Location  Note Categories 

 Position  Training/Certifications 

 Status  Document Categories 

 W-4 Status  Reminder Settings 

 Wage Type 

 

For example, use the Department information field in the General tab to define departments, such as 

―Marketing,‖ ―Sales,‖ and ―Administration.‖ 

 

To add a department: 

 
1. From the Define menu, select Department. The Department window is displayed. 

 

2. Click the Add button in the Department dialog box. A new line is displayed. 

 

3. Enter the new department name. 

 

4. Click Close when you are finished entering department names. 

 

You will repeat this procedure as you move through the Define menu setting your own specifications. You 

can edit or delete the changes you make at any time. 

  

Define Accrual Accounts 

The Accruals quick-tab allows you to track accrual accounts like vacation time, sick leave, comp time, and 

overtime. Accruals calculates and keeps a running balance of the amount (hours, days, etc.) entered. 

 

Accrual Accounts work with Auto Accrual Policies to automatically calculate time accruals for all employees 

enrolled in auto accruals. 

 

To set up Accrual Accounts you must first identify the accounts you’ll be using. ―Vacation‖ and ―Sick Leave‖ 

are already defined for you, but you may want to add ―Overtime.‖ You can define as many accrual accounts 

as you need for your company. 
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To add an accrual account: 

 

1. From the Define menu, select Accruals and Accrual Accounts. The Accruals Accounts window is 

displayed. 

 

2. Click the Add button and a new Accrual Accounts window is displayed. 

 

3. Enter the Accrual Account title or name and select how the time will be accrued: Hours or Days. 

 

4. Click Save. 

 

Define Auto Accrual Policies 

Auto Accrual Policies work with Accrual Accounts to automatically calculate time accruals for all employees 

enrolled in auto accruals. 

 

Two common accruals that companies offer employees are vacation and sick time. You can set up Auto 

Accrual Policies to apply accruals to employees based on hire date, trial periods, and seniority. The Auto 

Accrual Policies wizard walks you through a series of questions and uses your answers to set up the auto 

calculations. 

 

When you have inactive employees, you can create an Inactive Auto Accrual Policy using a custom accrual 

period to temporarily withhold employee accruals during the inactive period, such as for a short-term 

disability. When this policy is in effect, no auto accruals will be posted for the employees assigned the 

custom policy. 

 

To add an auto accrual policy: 

 

1.  From the Define menu, select Accruals > Auto Accrual Policies to display the Auto Accrual Policies 

window. 

 

2.  Click the Add button and the Auto Accrual Policy wizard opens. 

 

3.  Enter the Accrual Account Policy Name, such as Vacation—New Hires, and click Next to continue. 

 

4.  Select the Accrual Account this policy is posted to, such as Vacation. If the Accrual Account does not 

appear in the drop-down list, click the Add New button to define the account required. 

 

5.  If the policy you’re adding is based on an existing policy, select the existing policy from the drop-down 

list and click Next to continue. 

 

 NOTE: This selection is optional. The advantage to basing new policies on existing policies is that 

Staff Files populates the new policy with all information from the existing policy. When you have 

minor adjustments to make, this saves you the time of re-entering each and every policy item, and 

instead you make only the necessary adjustments. 
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6.  Select the Accrual Period, or the frequency with which time is accrued for this policy, and click Next 

to continue. For example, weekly accruals will post accrued time to enrolled employees at the end of 

each week. 

 

7.  Select the time that identifies the start of the accrual year. When will an accrual year begin? could be 

a particular month or the anniversary of the hire date. 

 

 NOTE: Staff Files and Staff Files Pro process time carryovers each accrual year on the first day of the 

month selected, or on each anniversary of the date the employee was hired. 

 

8.  Define the first year only Accrual Rates for the new policy. This rate applies to new employees who 

have been with you less than one year and who will accrue time at a different rate than those 

employed for more than one year. 

 

NOTE: You can control the accrual rates during each month of the first year of employment. 

 

(In a following step you define rates for employees that have been with you more than one year using 

a seniority table.) 

 

9.  If your policy will use a Trial Period, select the appropriate trial period length. This often applies to 

newly hired employees. 

 

NOTE: During a trial period employees will accrue time, but it will not be awarded until after the trial 

period is completed. 

 

10. Mark the Reset Option when the new policy resets the accrual balance at the end of the accrual 

year. For example, policies that enforce ―use-it-or-lose-it‖ rules would reset to zero at the end of the 

accrual year. 

 

11. Use the Seniority Table to define the accrual rates used for employees enrolled in the new policy 

after their first year. These rates begin to accrue when the employee has been with you more than 

one year, and the rates here are based on their length of employment. 

 

To use the seniority table: 

 Click the Add button to add a seniority record. 

 Enter the number of years of service required. 

 Enter the number of days or hours to be accrued each month. 

 If applicable, enter maximum amount of unused time that will be carried over in the next year.  

 Enter the maximum number of days to be accrued, or select N/A if this is not applicable, and 

click Save. 

 

NOTE: If you do not use seniority to calculate accruals, enter a single seniority record to indicate the 

amount to be accrued after the first year of employment. 

 

12. Click Next to display the Accrual Policy Summary, where you can review or print your selections 

before completing the wizard. 

 

13. Click Finish to save the new Accrual Account Policy. 
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Change a Field Label 

Staff Files and Staff Files Pro provide additional flexibility for customizing your employee records by allowing 

you to change the field labels displayed in the tabs. For example, you may want to change the Department 

label that is displayed in the General tab, to ―Division‖ or ―Regional Office.‖ 

 

To change a field label: 

 

1.  Click the tab containing the label you want to change. 

 

2. Place the cursor on the label and double-click. The Label Edit dialog box is displayed. 

 

3. Type a new label in the text box. 

 

4. Click OK. 

 

The new label will now appear in the tab and in the Define menu, and the new label has its own hot 

key when you push the Alt Key. 

 

NOTE: After making this change, use the Define feature to edit the options that appear in the drop-

down list, if appropriate. 

 

 

Enter Dates 

Date information fields (Birth Date, Hire Date, Next Review Date, etc.) have a Calendar button. 

 

To enter a date:   

  

1. Click the Calendar button to display the calendar. 

 

2. Use the arrows at the top to scroll to the appropriate date. 

 

3. Select the date by double-clicking, and it will be entered in the field. 

 

Custom Sorts 

Staff Files and Staff Files Pro allow you to set the order employee names appear in the employee selection 

lists and on reports. Staff Files has defined four sorts for you: ―Hire Date/Seniority,‖ ―Location,‖ 

"Job/Position," and ―Active Employees.‖ You can define up to six additional sort fields. Your sorting choice 

can be applied at any time, and you can edit or delete sorts as needed. 
  

Define a custom sort: 

  
1. Click Define from the menu bar and select Sorts. 

 

2. Click New in the Sort dialog box to display a ―worksheet‖ of fields for defining new sorts. 
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3. Enter a name for your new sort in the Name box. This name is displayed in the drop-down list when 

you select Sort from the Define menu, or when you click the Filter and Sort button in the tool bar. 

 

4. In the Sort Field 1 column, use the drop-down list to select the Sort Field you want to use as your 

primary field. 

 

5. In the same column, select how you want the records sorted in the Sort Order drop-down list: 

Ascending or Descending order. 

 

6. If necessary, continue defining up to five additional sort fields in the remaining columns. 

 

7. Click OK when finished, then click OK again. 

 

Use a custom sort: 

 
1. Click the Sort button in the tool bar. The Filter and Sort dialog box is displayed. 

 Or, from the Define menu, select Sort.  

 

2. Click the drop-down arrow, and select the desired sort. 

 

3. Click OK. 

 

NOTE: If necessary, you will also choose a Filter. 
 

Custom Filters 

Staff Files and Staff Files Pro allow you to build your own filters to increase reporting capabilities. You can 

combine filters with different sorts to further increase your reporting capabilities. For example, you could sort 

your staff by hire date, and include only those hired after 1/1/2000 with a filter. These filters are defined for 

you: ―Active Employees,‖ ―Inactive Employees,‖ and ―Terminated Employees.‖ You can edit or delete filters, 

as needed. 

 

Defining a filter requires you to: 

 Select a Filter Field - You will select this from the list of information fields that appear in your Staff 

Files tabs. 

 Select an Operator Command - Operators include: AND, OR, >, <, >=, <=, +, –, LIKE, IN, and DATE(). 

 Identify the Variable Data-You will type in the data you want to filter. For example, to filter only 

managers, you would type ―Manager.‖ 

 

Define a custom filter: 

 
1. Click the Define menu and select Filters. The Filters dialog box is displayed. 

 

2. Click New to create a new filter. 

 

3. Enter the name of the new filter in the Name field of the Edit Filter dialog box. This name appears in 

the drop-down list when you select Filter and Sort from the View menu. 
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4. Select an information Field from the fields list box on the left. The Field you selected appears in the 

Filter text box at the bottom of the dialog box. 

 

5. Select an Operator from the list of operators on the right. The Operator you selected now appears in 

the Filter text box at the bottom of the dialog box along with the Filter. 

 

6. Select a Value from the list of values on the right. The Value you selected now appears in the Filter 

text box at the bottom of the dialog box along with the Filter and Operator. 

 

7. Click Insert Criteria to enter the Filter you defined. For example, the filter could be Department (Field) 

equals (Operator) Sales (Value). 

 

8. Click Test Filter to check your work. If you have defined your filter correctly, you will receive an OK 

message. 

 

9.  Click Add Connector if you need to include OR or AND to the filter you’re creating and make your 

additions. 

 

10. Click OK, and then click OK again. 

 

Use a filter: 

 
1. Click the Filter and Sorts button in the tool bar or from the View menu, select Filter and Sort, where 

you can apply both at the same time, if desired. 

2. Click the drop-down arrow, and select the desired filter. 

 

3. Click OK. 

 

Set Up & View Reminders 

Staff Files and Staff Files Pro feature a built-in reminder system. It pops-up messages you’ve set up each 

time you start the Staff Files program. Staff Files also features an e-mail reminder system, allowing you to 

send an e-mail reminder to the employee as well. 

  

Reminders include the text you enter in the Reminders tab for an employee. The built-in reminder system 

also has a function that allows you to view all reminders. 

 

Additionally, you can define up to five of the date fields in the User tab and set them up as customized, 

universal reminders for such things as parking pass expirations. 

 

Set a reminder to pop-up when you need to backup your database. You determine how frequently you want 

the message to appear. This reminder will appear when you first open Staff Files. 

 

To set a backup reminder: 

 

1. Click the Define menu and select Backup Reminder. The DB Backup Options dialog box is displayed. 

 

2. Be sure to mark the Remind me... check box to activate the reminder. 
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3.  Enter a number to indicate how many days between reminders. 

 

4.  Click OK. 

 

 NOTE: You can deactivate the Backup Reminder when you open Staff Files. Simply click the Disable 

all future Database Backup Reminders box. The checkmark is displayed to indicate it is no longer 

active. Click OK. You can reactivate the reminder by going to Backup Reminder in the Define menu 

 

The Current Reminders feature allows you to view a complete list of your reminders. These reminders are: 

 Anniversaries 

 Benefit Eligibility 

 Birthdays 

 I-9 Renewals 

 Reviews 

 Reminders (defined in the Reminders tab) 

 Training/Certifications 

 

To view current reminders: 

 

1. Click the View menu and select Current Reminders. The Current Reminders dialog box is displayed. 

 

2.  Select the reminder you want to view from the Reminders list. The details of the reminder are 

displayed in the fields at the right. 

 

3.  Click Close when you are finished viewing the reminders. 

 

 NOTE: Reminders will continue to be displayed until you have deleted them. To delete, simply click 

the Delete checkbox. 

 

The Staff Files E-mail Reminder works with your system’s default e-mail program. Staff Files will send the 

reminder to the e-mail address you identify in the employee’s General information tab. 

 

To set up e-mail reminders: 

 

1. Click the View menu and select Current Reminders. The Current Reminders dialog box is displayed. 

 

2. In the Reminders list, click the reminder you would like to e-mail, and it becomes highlighted. 

 

3. The details of the reminder will be displayed in the fields below. To add additional information to your 

e-mail, use the message box of your e-mail program. 

 

4. Click the E-mail This Reminder button. 

 

 NOTE: You will receive an Error Message if you have not set up the default e-mail system, or if you 

have not entered an e-mail address for the employee in the General tab. 
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Manage Security 

Staff Files and Staff Files Pro have a multi-level password system and flexible access settings. You can allow 

access to one or more tabs, such as the General and Emergency tabs, and restrict access to sensitive 

information in other tabs, such as Wages, Reminders, and Evaluations. You can set manager access to view 

information for their specific department only, and lock the Define menu to keep company-defined 

information, such as accrual policies, safe from alterations. You can restrict access to your reports as well, 

and limit the ability to delete employee records. 

 

You can choose between Windows Authentication and Staff Files Authentication. And, if you are using your 

Staff Files or Staff Files Pro information in a Microsoft Access database, you can also define a password to 

protect the information from being manipulated through Access. Restrict access to your reports as well. 

 

NOTE: It is recommended you first install Staff Files or Staff Files Pro on the administrator machine and set 

up user access and rights. Then, install Staff Files or Staff Files Pro to remaining workstations for multi-user 

licenses. 

 

To manage security: 

 

1.  From the File menu, select Manage Security. The program displays the Manage Users/Database 

dialog box. 

 

2.  Go to the Authentication tab and be sure that the authentication setting here matches the 

authentication scheme used to gain access to the users’ computers.  

  

 NOTE: Windows Authentication is the recommended authentication setting. If Staff Files or Staff Files 

Pro is already set for Windows Authentication, the setting button will display ―Change to Staff Files 

Authentication‖ and no action is required. If the setting button displays ―Change to Windows 

Authentication‖, click the button to make the necessary change. 

 

3.  Go to the Users tab, and enter or select the user you are setting up for security. 

 

 Or, choose Add, if you’re entering a new user that isn’t already included in the list. You must enter a 

valid username from their computer or domain. 

 

4.  Mark Read Only for access that allows viewing information only. This will restrict them from making 

any changes to records. 

 

5.  In the Access To section, mark each item you are allowing the user to access. 

 

6.  In the Department section, mark All Departments to allow complete access or mark Following 

Departments and enter the specific department, or departments, you’re allowing access to. 

 

7.  Go to the Database Password tab and enter the password to be used for accessing the Microsoft 

Access database, if you choose to use this optional feature. 

 

8. Click Close when you are finished. 

 

NOTE: To delete a user from the list, select the user and click Delete. 



  23 Staff Files & Staff Files Pro version 8.0 

 

User Agreement 

PLEASE READ THIS DOCUMENT CAREFULLY BEFORE USING THIS SOFTWARE 

 

By using this computer program ("Software"), you agree to become bound by the terms of this Agreement. If you do not agree to the terms of this 

Agreement, do not use the Software and promptly return the package within 10 days to the place where you obtained it for a full refund. 

 

This Software is sold to you (owner of the product) by Atlas Business Solutions, Inc. ("ABS"), for use only under the terms of this Agreement, and ABS 

reserves any rights not expressly granted to you. 

  

1.  Uses.  This Agreement allows you to: 

 

(a) Use the Software on a single microcomputer at a time, except the Software may be executed from a common disk shared by multiple CPUs 

provided that one authorized copy of the Software has been purchased from ABS for each CPU executing the Software. ABS does not, however, 

guarantee that the Software will function properly in your multiple-CPU, multi-user environment. The Software may not be used with any gateways, 

bridges, modems, and/or network extenders that allow the Software to be used on multiple CPUs, unless one authorized copy of the Software has 

been obtained from ABS for each CPU or terminal executing the Software. 

 

(b) Make one copy of the Software in machine-readable form solely for backup purposes. The Software is protected by United States copyright law. 

You must reproduce on each copy the copyright notice and any other proprietary legends that were on the original copy supplied by ABS. 

 

2.  Restrictions: 

 

You may not distribute copies of the Software to others or electronically transfer the Software from one computer to another over a network and/or 

zone. The Software contains trade secrets and to protect them you may not decompile, reverse engineer, disassemble, crossassemble or otherwise 

change and/or reduce the Software to any other form. You may not modify, adapt, translate, rent, lease, loan, resell for profit, distribute, network or 

create derivative works based upon the Software or any part thereof.   

 

3.  Termination: 

 

This Agreement is effective until terminated. This Agreement will terminate immediately without notice from ABS if you fail to comply with any 

provision of this Agreement Upon termination you must destroy the Software and all copies thereof. You may terminate this Agreement at any time by 

destroying the Software and all copies thereof.  

 

4.  Export Law Assurance: 

 

You agree that the Software will not be shipped, transferred, or exported directly into any country prohibited by the United States Export 

Administration Act and the regulations thereunder nor will be used for any purpose prohibited by the Act. 

 

5.  Limited Warranty, Disclaimers, Limitation of Remedies and Damages: 

 

ABS' warranty on the media, including any warranty of merchantability or fitness for a particular purpose, is limited in duration to thirty (30) days from 

the date of the original retail purchase of this product. After that period, if a disk fails to work or if a disk becomes damaged, you may obtain a 

replacement disk by returning the original disk. Contact ABS for instructions on obtaining replacement disks. 

 

The replacement warranty set forth above is the sole and exclusive remedy against ABS for breach of warranty, express or implied, or for any default 

whatsoever relating to the condition of the Software. ABS makes no other warranties or representation, either expressed or implied, with respect to 

this Software or documentation, its quality, merchantability, performance, or fitness for a particular purpose. As a result, this Software is sold with 

only the limited warranty with respect to diskette replacement as provided above, and you, the owner, are assuming all other risks as to its quality 

and performance. In no event will ABS or its developers, directors, officers, employees, or affiliates be liable for direct, indirect, special, or 

consequential damages (including damages for loss of business profits, business interruption, loss of business information and the like) resulting 

from any defect in this Software or accompanying documentation or arising out of the inability to use the Software or accompanying documentation 

even if ABS, an authorized ABS representative, or an affiliate has been advised of the possibility of such damage.   

 

No oral or written information or advice given by ABS, its dealers, distributors, agents, affiliates, developers, directors, officers, or employees shall 

create a warranty or any way increase the scope of this warranty. Some states do not allow the exclusion or limitation of implied warranties or 

liabilities for incidental or consequential damages, so the above limitation and exclusion may apply to you. This warranty gives you the specific legal 

rights, and you may also have other rights that vary from state to state. 

 

6.  Copyright Notice: 

 

This Software and accompanying manual (or documentation) are copyrighted with all rights reserved by Atlas Business Solutions, Inc. Under United 

States Copyright Laws, the Software and its accompanying documentation may not be copied in whole or in part, except in normal use of the Software 

or to make a backup copy for archival purposes only. Any other copying or selling or otherwise distributing this Software is hereby expressly forbidden. 
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